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Distinctively Oriental
Take-home menu captures the flavor of the Far East in a unique Oriental format

Before (above)
Just the facts, ma’am. The 
data’s all here, but delete 
the bowl, and there’s not 
one visual clue to let us 
know this sheet is about 
Chinese cuisine. A take-out 
menu needs the diner’s eyes 
to do what his nose can’t—
lure him back to the restau-
rant. That requires beauty.

Delicious, savory, mouth-watering Chinese 
cuisine—that’s what the business-lunch crowd 
gets at A Taste of the Orient, a small, family-owned 
restaurant inside a neighborhood shopping mall. 

But you’d never know that by 
looking at their menu (right), a 

plain, pink leftover from the 
Ming Dynasty 

(14th-century 
English period). It’s so nondescript! 

A Taste of the Orient needs a menu 
that’s as beautiful as its food is 
tasty and that conveys its distinctive, 
Chinese culture. It needs a menu 

that will be posted on the office 
bulletin board, not hidden in the 

bottom drawer. Let’s make one.
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It’s not designed at all
The ink’s on the paper, all right, but the page is not designed; it’s just filled in. 
The designer left his visual tools of scale, contrast and depth at home!

Accidental design
Good design is intentional. At left, three circles and three 
rectangles have been arranged in two triangles around a focal 
point centered in the large circle (the platter). That’s design, 
and it’s attractive. Above, the center panel is typographically 
different from the other two—a normal visual device—but for 
no apparent reason. That’s accidental, and it’s unattractive. 

Boxes everywhere
Boxes corral the many kinds of dishes. This makes 
sense organizationally, but the pencil-thin lines 
have no beauty and are unnecessary, too; the 
open space alone is sufficient to create separation 
between sections. Random margin widths disrupt 
any possible visual rhythm.

(Right) The outside panel has a 
focal point (the bowl), and it’s 
in the right place (the center), 
but it’s too small—too much 
like everything else—to have an 
impact. The name’s in a good place, 
too, surrounded by (mainly) open 
space, which makes it easy to 
read, but it’s so nondescript it has 
no voice. Name, location, phone 
number and hours are all needed 
to do business, but unlike what 
the chef prepares, none of it has 
been artfully presented.

Inside spreadOutside spread
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Look. Read. Learn.
Begin the redesign by researching what Chinese looks like. Actually do the 
work. Don’t rely on your memory, or you’ll end up using clichés like fortune 
cookies and chopsticks.

The world of China 
Don’t dream up images—
you’ll get better results (more 
easily, too) if you look them 
up! Research books, maga-
zines and online photo sourc-
es. Visit Chinese restaurants. 
What to watch for? Pay atten-
tion to physical attributes 
like shapes, colors, textures; 
sensual qualities like sound, 
smell, touch; and hidden 
intangibles, especially of his-
tory, culture and tradition.

Fortune cookie “Moon 
cakes” predate Ming Dynasty; 
sweet, happy, circular, tan 

Bamboo 
Natural, elegant, 
cool, spare

Screen  Fine furniture, inlaid, 
historic, story-telling, seen in 
the restaurant

Characters Ancient, wet 
brush, calligraphic, fluid, 
painstaking, distinctively
Oriental 

Colors Red, gold leaf

Mask Ancient, heroic, religious, 
theatrical, colorful, multi-textured

Restaurant Neutral colors, spot 
lighting, intricate woodwork Wok Colorful, hot, fresh, 

round, aromatic
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Start with format and background
Two images can anchor the design—the folding screen because it resembles the 
folded sheet, and the bamboo plant, which will make a graceful, placid background.

Crop the image
Like the story on a folding screen, crop the image 
to span the page and fit its proportions. Note how it’s 
balanced—about half image, half background.

Screens are usually decorated with landscapes, plants 
and figures and typically have three or four panels. Con-
veniently enough, the two-fold menu has three panels. 

With the image in place, it’s time to turn 
the background into a beautiful canvas 
on which to paint our words.
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Create a silhouette
To create the illusion of a shadow cast against the screen—or visible through 
the screen—first separate the bamboo from its background.

What we’re about to do is reduce the 
full-color photo to solid black & white 
with no grays. For an organic image 
like this one with a distinct silhou-
ette and where precision is not vital, 
Photoshop’s Threshold slider is ideal.

Invert and clean up 
Invert black and white by selecting 
Image>Adjustments>Invert. Erase any 
leftover spots and unwanted parts. If 
necessary, use the Brush tool to paint 
and redefine some parts. Save a copy 
(or a layer) of this image to use later.

Open the image 
Change its mode to Grayscale 
(Image>Mode>Grayscale).

Set the threshold 
Select Image>Adjustments> 
Threshold, check Preview, and move 
the Threshold slider. Everything 
above the threshold is white, and 
everything below is black. Adjust for 
greatest clarity, then click OK. 
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Create the illusion of natural lightthe wall
Turn the black silhouette into a soft shadow by blurring and lightening. 
Then paint depth and radiance onto the whole page.

Add depth and radiance
Next, mimic the dark and light qualities of natu-
ral light. First, sample a light and dark color from 
the restaurant (1 ). (This “color connection” is an 
artistic tie-in.) Create a new layer, and fill it with 
the light color (2). With the darker color and a 
fairly large, soft brush, make a smooth, sweep-
ing stroke across the page (3).

Combine 
Set the new layer’s 
blending mode to 
Multiply, which 
allows the bamboo 
layer beneath to 
show through. The 
result is a convinc-
ing illusion of bam-
boo seen through 
a paper screen.

Blur and lighten 
Return the image to CMYK Mode 
(Image>Mode>CMYK). To soften, 
select Filter>Blur>Gaussian Blur, and 
enter a Radius amount. What you 
want is a soft but still-distinct silhou-
ette, which in this case was 10 pixels. 
Lighten the result by lowering the 
opacity to about 10%.

1

2

3
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Add bamboo to the foreground
With the shadow and lighting established, give the page more depth by adding 
black bamboo, which yields a beautiful foreground-background effect.

Connect 
Get artistic! With the Brush tool, create your own bam-
boo plant by connecting the leaves (1) and adding a 
stem (2) that anchors plant to page. Then add another 
leaf (3) to serve as a downward pointer to the list of 
menu items that will eventually go beneath it.

Separate 
Note that as big as the shadow is, its light value and soft 
edges make it recede. Create a forward dimension by 
moving black leaves to the center of each panel. The con-
trasts of edge (hard and soft) and overlapping elements 
(dark, medium, light) results in real depth.

Isolate 
Retrieve the saved black & 
white copy, move its layer to 
the top, and set its blending 
mode to Multiply. With the 
Brush and Eraser tools, iso-
late a few bamboo leaves.

1

2

3
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Create a focal icon
The original bowl is a good, simple icon for the restaurant; it suggests eating, 
chopsticks say Chinese, and steam says hot and fresh. A stamplike effect makes 
it bolder and even more Chinese.

3) Sharpen, then dab
In Filter>Sharpen>Unsharp 
Mask, apply the following set-
tings: Amount: 100; Radius: 25; 
Threshold: 0. Click OK. Next, 
with white as the Foreground 
color, select the Spatter brush 
(here, number 39). Using vari-
ous brush sizes and opacities, 
click-dab to soften and basi-
cally mess up the edges.

2) Roughen the edges
Set the Foreground and Back-
ground colors to red and 
white, respectively. Go to 
Filter>Sketch>Torn Edges, 
and for this size and resolu-
tion enter the following: Image 
Balance: 25; Smoothness: 1; 
Contrast: 15. Click OK.

In Chinese brush paintings, a 
stamp, which is typically red, 
is often used as a signature. Its
imagery can be evoked by turn-
ing the bowl into a stamp. 

A rubber stamp begins as a fairly 
sharp image that degrades as it 
unevenly hits the paper and more 
as the ink soaks in. Time can further 
wear it down. The result is a rich, 
interesting texture. Here’s how to 
mimic that in Photoshop.

1) Create the image
The original image can come 
from almost any source (ours 
was a scan), so in some way 
get it into a Photoshop file—
Resolution 300 ppi, Color 
Mode RGB Color, Background 
Contents Transparent—turn it 
into a selection, and knock it 
out of a shape you’ve drawn. 
You want the results to 
resemble the image above.

Click . . .
. . .dab . . .
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r Choc ICG Regular

• No brush marks
• No bleeding
• Clean edges and ends
• Poster-like

Orient

r Visigoth Regular

• Fat, slow strokes
• Fairly upright
• Soaked into the surface
• Visible paper texture

Orient rRuach Plain

• Fast, light strokes
• Clean edges and rough ends
• Closest to handwritten
• Most like the sample

Orient

Select a display type
Nothing evokes China as readily as its unique, calligraphic characters, which on the 
menu must be conveyed with Western-style type. In general, you’ll see wet brush, dry 
brush and artificial styles. Dry-brush font Ruach in this case is best.

Wet brush

Dry brush

Artificial
Reference character

Once you’ve found a style that 
you like, note how it’s drawn. 

Pay attention to its edges, 
stroke ends, thick-to-thinness 
and general slant or direction, 

then look for similarities in 
Western typestyles.
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Appetizers
Fried Won Ton
Egg Rolls (4)
Paper-wrapped Chicken (8)
Fried Chicken Wings (10)
Pot-Stickers (8)

Appetizers
Fried Won Ton
Egg Rolls (4)
Paper-wrapped Chicken (8)
Fried Chicken Wings (10)
Pot-Stickers (8)

Appetizers
Fried Won Ton
Egg Rolls (4)
Paper-wrapped Chicken (8)
Fried Chicken Wings (10)
Pot-Stickers (8)

Calligraphic  Sanvito

Simple lines, BIG counters, BIG aper-
tures and a sweeping stroke yield 
both clarity and calligraphic style 
without the brush details. Sanvito 
is a good complement to Ruach.

Sans-serif  Helvetica

Although popular, Helvetica is not espe-
cially clear at small sizes, because its 
small apertures tend to close up. And 
its straight lines are too rigid to comple-
ment free-flowing Ruach. 

Roman serif  Times Roman

Roman serif faces are more refined 
and generally easier to read, because 
serifs help move the eye from letter to 
letter, but they’re full of tiny detail and 
stylistically very different from Ruach.

Select a complementary text typeface
For the small type used for listings, look first for clarity and then for a complementary 
line or shape. Clarity usually requires “open” letterforms and little detail.

Tc Small, but serifs 
help move the eye Tc Sweeping 

and openTc Too smallToo straight

http://www.bamagazine.com
http://www.bamagazine.com
http://www.bamagazine.com
http://www.bamagazine.com
http://www.bamagazine.com/email/jum6nU


Before&After ® XiBAmagazine.com U

Distinctively Oriental   0614  12 of 20   

Distinctively Oriental       12 of 20

(Left) Analyze the bamboo based on line and direction. Note that its leaves and 
stems point in different directions—horizontal, diagonal, vertical—which creates 
a lot of movement and tension. This action can be mimicked in the layout.

Complement image and layout
With the bamboo already on the page, create a relationship between image, type 
and layout by mimicking its spiky visual qualities.

Place the contact 
information
Since this is a take-
home menu, the 
phone number needs 
to be prominent; 
here, its size and 
right offset make it 
stand out. Remaining 
information aligned 
with the seal estab-
lishes continuity yet 
retains the staggered 
movement.

Place the 
business name
The bamboo leaves 
have both size and 
directional differ-
ences. Mimic this 
with two type sizes 
and staggered place-
ment, which moves 
the eye similarly and 
puts tension into 
the layout.

Place the seal
What size should 
the seal be? Gener-
ally speaking, work 
with what’s in front 
of you. Here, the 
bamboo is govern-
ing the design, so 
give the seal similar 
mass, and place it 
directly beneath the 
downward-pointing 

“umbrella” about 
mid-page. 

The Orient
A taste of

Aligned with seal for continuity

  

 3315 Northgate Blvd. #8, Sacramento

 Corner of Northgate & San Juan

 Open M–Sat. from 11–9, closed Sunday

 Dine-In • Take-Out • Catering

  916.922.1818

The Orient
A taste of
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Organize the menu items
All those boxes on the original menu are unnecessary; the white space alone is 
sufficient to separate the sections beautifully. Simple tab indents identify columnar 
elements and mimic the bamboo, too. 

Special Rice Plates
 (Entree without shrimp 4.25)
 1. Sa-tay Chicken or Pork
 2. Teriyaki Chicken or Pork
 3. Sweet & Sour Chicken or Pork
 4. Kung Pao Chicken
 5. Szechwan Beef *
 6. Mongolian Beef *
 7. Curry Chicken *
 8. Broccoli Beef
 9. Sesame Chicken
 10. Lemon Chicken
 11. Cashew Chicken
 12. Garlic Chicken
 13. Hunan Chicken
 14. Vegetable Deluxe *
 (Entree with shrimp 5.25)
 15. Cashew Shrimp
 16.  Kung Pao Shrimp
 17. Szechwan Shrimp *
 18. Curry Shrimp
 19. Shrimp with black bean sauce
 20. Shrimp with lobster sauce

Family Specials (2–3 people)
 Cantonese Family Special  14.95
   Soup of the Day
   Egg Rolls
   Broccoli Beef
   Teriyaki Chicken
   B.B.Q. Pork Fried Rice

 Mandarin Family Special  15.95
   Soup of the Day
   Fried Prawns
   Mongolian Beef
   Sa-tay Chicken
   B.B.Q. Pork Chow Mein

 House Family Special  16.95
   Soup of the Day
   Paper-wrapped Chicken
   Cashew Prawn
   Sesame Chicken
   Shrimp Chow Mein
 

The Orient

  

 3315 Northgate Blvd. #8, Sacramento

 Corner of Northgate & San Juan

 Open M–Sat. from 11–9, closed Sunday

 Dine-In • Take-Out • Catering

  916.922.1818

A taste of

Tab indents rather than flush-left alignment yield text 
blocks that have staggered edges similar to the bamboo 
and cover layout.

Visual relationships 
Above, the headline x-height deter-

mines the text size. Below, its overall 
height governs section spacing.

Family Specials (2–3 people)
 Cantonese Family Special    14.95
   Soup of the Day
   Egg Rolls
   Broccoli Beef
   Teriyaki Chicken
   B.B.Q. Pork Fried Rice

 Mandarin Family Special               15.95
   Soup of the Day
   Fried Prawns 

Family Specials

Family Specials
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Repeat inside
What’s good for the outside is good for the inside. Create continuity easily by 
repeating the background, margins, column guides and type treatment inside.

Repeat the background Use the same background image 
inside as outside, but to make space for the menu items 
delete the foreground silhouettes. Carry over margins, guides 
and type treatment. Note that the bamboo shadow is reversed 
to create the illusion of transparent rice paper.

Pork
 Sweet & Sour Pork                                     5.95
 Garlic Pork (with vegetables)                 5.95
 Sa-tay Pork                                                   5.95
 Teriyaki Pork                                               5.95
 B.B.Q. Pork Bean Curd                               5.95

Poultry
 Broccoli Chicken                                         5.25
 Almond Chicken                                         5.25
 Cashew Chicken                                          5.25
 Szechwan Chicken *                                  5.25
 Kung Pao Chicken *                                   5.25
 Hunan Chicken *                                        5.95
 Curry Chicken *                                          5.95
 Sweet & Sour Chicken                              5.95
 Sa-tay Chicken                                             5.95
 Lemon Chicken                                           5.95
 Sesame Chicken                                           5.95
 Teriyaki Chicken                                        5.95
 Garlic Chicken                                             5.95

Beef
 Broccoli Beef                                                 5.95
 Mongolian Beef *                                        5.95
 Szechwan Beef *                                          5.95
 Kung Pao Beef *                                           5.95
 Hunan Beef *                                                6.95
 Beef with Oyster Sauce                             5.95
 Ginger Beef                                                   5.95
 Pepper Beef (with black bean)               5.95

Appetizers
 Fried Won Ton 2.95
 Egg Rolls (4) 4.25
 Paper-wrapped Chicken (8) 4.25
 Fried Chicken Wings (10) 4.25
 Pot Stickers (8) 4.95
 Fried Prawns (8) 4.95
 Fried Calamari 5.95
 Chinese Chicken Salad 4.25

Soup
 Soup of the Day 1.50
 Egg Flower Soup 4.25
 Chicken Noodle Soup 4.25
 Beef Noodle Soup 4.25
 Won Ton Noodle Soup 4.25
 Won Ton Soup 4.25
 Combination Won Ton 5.25
 Hot & Sour Soup * 5.25

Combination Plates
 Combination Plate #1 5.25
   Soup of the Day
   Paper-wrapped Chicken
   Broccoli Beef
   Chow Mein or Fried Rice

 Combination Plate #2 6.25
   Soup of the Day
   Fried Prawns
   Sweet & Sour Chicken
   Chow Mein or Fried Rice

Seafood
 Cashew                                                           6.95
 Prawn with lobster sauce                         6.95
 Prawn with black bean sauce                 6.95
 Sweet & Sour Prawn                                 6.95
 Curry Prawn (or calamari) *                   6.95
 Kung Pao Prawn (or calamari) *            6.95
 Szechwan Prawn *                                     6.95
 Vegetable with Prawn                               6.95

Vegetables
 Vegetable Deluxe                                       5.25
 Szechwan Bean Curd *                              5.25
 Braised Bean Curd                                      5.95

Fried Rice
 Vegetarian Fried Rice                                4.25
 Chicken Fried Rice                                     4.25
 B.B.Q. Pork Fried Rice                               4.25
 Beef Fried Rice                                             4.25
 Shrimp Fried Rice                                       5.25
 Combination Fried Rice                            5.25

Chow Mein
 Vegetarian Chow Mein                             4.25
 Chicken Chow Mein                                  4.25
 B.B.Q. Pork Chow Mein                            4.25
 Beef Chow Mein                                          4.25
 Shrimp Chow Mein                                    5.25
 Combination Chow Mein                        5.25

 * Hot & Spicy

Inside spreadOutside spread

Special Rice Plates
 (Entree without shrimp 4.25)
 1. Sa-tay Chicken or Pork
 2. Teriyaki Chicken or Pork
 3. Sweet & Sour Chicken or Pork
 4. Kung Pao Chicken
 5. Szechwan Beef *
 6. Mongolian Beef *
 7. Curry Chicken *
 8. Broccoli Beef
 9. Sesame Chicken
 10. Lemon Chicken
 11. Cashew Chicken
 12. Garlic Chicken
 13. Hunan Chicken
 14. Vegetable Deluxe *
 (Entree with shrimp 5.25)
 15. Cashew Shrimp
 16.  Kung Pao Shrimp
 17. Szechwan Shrimp *
 18. Curry Shrimp
 19. Shrimp with black bean sauce
 20. Shrimp with lobster sauce

Family Specials (2–3 people)
 Cantonese Family Special  14.95
   Soup of the Day
   Egg Rolls
   Broccoli Beef
   Teriyaki Chicken
   B.B.Q. Pork Fried Rice

 Mandarin Family Special  15.95
   Soup of the Day
   Fried Prawns
   Mongolian Beef
   Sa-tay Chicken
   B.B.Q. Pork Chow Mein

 House Family Special  16.95
   Soup of the Day
   Paper-wrapped Chicken
   Cashew Prawn
   Sesame Chicken
   Shrimp Chow Mein
 

The Orient

  

 3315 Northgate Blvd. #8, Sacramento

 Corner of Northgate & San Juan

 Open M–Sat. from 11–9, closed Sunday

 Dine-In • Take-Out • Catering

  916.922.1818

A taste of
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The Orient

  

 3315 Northgate Blvd. #8, Sacramento

 Corner of Northgate & San Juan

 Open M–Sat. from 11–9, closed Sunday

 Dine-In • Take-Out • Catering

A taste of

Special Rice Plates
 (Entree without shrimp 4.25)
 1. Sa-tay Chicken or Pork
 2. Teriyaki Chicken or Pork
 3. Sweet & Sour Chicken or Pork
 4. Kung Pao Chicken
 5. Szechwan Beef *
 6. Mongolian Beef *
 7. Curry Chicken *
 8. Broccoli Beef
 9. Sesame Chicken
 10. Lemon Chicken
 11. Cashew Chicken
 12. Garlic Chicken
 13. Hunan Chicken
 14. Vegetable Deluxe *
 (Entree with shrimp 5.25)
 15. Cashew Shrimp
 16.  Kung Pao Shrimp
 17. Szechwan Shrimp *
 18. Curry Shrimp
 19. Shrimp with black bean sauce
 20. Shrimp with lobster sauce

  916.922.1818

Family Specials (2–3 people)
 Cantonese Family Special  14.95
   Soup of the Day
   Egg Rolls
   Broccoli Beef
   Teriyaki Chicken
   B.B.Q. Pork Fried Rice

 Mandarin Family Special  15.95
   Soup of the Day
   Fried Prawns
   Mongolian Beef
   Sa-tay Chicken
   B.B.Q. Pork Chow Mein

 House Family Special  16.95
   Soup of the Day
   Paper-wrapped Chicken
   Cashew Prawn
   Sesame Chicken
   Shrimp Chow Mein
 

Phone number in gold 
distinguishes it from the food 
categories and adds another 
level of depth. 

Color unifies the elements
It’s time to add color. Our eyes connect similarities—this like that. Color the 
headlines to match the seal already on the cover. The contrast of gold adds depth 
and spices up the hot palette. 

Pork
 Sweet & Sour Pork                                     5.95
 Garlic Pork (with vegetables)                 5.95
 Sa-tay Pork                                                   5.95
 Teriyaki Pork                                               5.95
 B.B.Q. Pork Bean Curd                               5.95

Poultry
 Broccoli Chicken                                         5.25
 Almond Chicken                                         5.25
 Cashew Chicken                                          5.25
 Szechwan Chicken *                                  5.25
 Kung Pao Chicken *                                   5.25
 Hunan Chicken *                                        5.95
 Curry Chicken *                                          5.95
 Sweet & Sour Chicken                              5.95
 Sa-tay Chicken                                             5.95
 Lemon Chicken                                           5.95
 Sesame Chicken                                           5.95
 Teriyaki Chicken                                        5.95
 Garlic Chicken                                             5.95

Beef
 Broccoli Beef                                                 5.95
 Mongolian Beef *                                        5.95
 Szechwan Beef *                                          5.95
 Kung Pao Beef *                                           5.95
 Hunan Beef *                                                6.95
 Beef with Oyster Sauce                             5.95
 Ginger Beef                                                   5.95
 Pepper Beef (with black bean)               5.95

Appetizers
 Fried Won Ton 2.95
 Egg Rolls (4) 4.25
 Paper-wrapped Chicken (8) 4.25
 Fried Chicken Wings (10) 4.25
 Pot Stickers (8) 4.95
 Fried Prawns (8) 4.95
 Fried Calamari 5.95
 Chinese Chicken Salad 4.25

Soup
 Soup of the Day 1.50
 Egg Flower Soup 4.25
 Chicken Noodle Soup 4.25
 Beef Noodle Soup 4.25
 Won Ton Noodle Soup 4.25
 Won Ton Soup 4.25
 Combination Won Ton 5.25
 Hot & Sour Soup * 5.25

Combination Plates
 Combination Plate #1 5.25
   Soup of the Day
   Paper-wrapped Chicken
   Broccoli Beef
   Chow Mein or Fried Rice

 Combination Plate #2 6.25
   Soup of the Day
   Fried Prawns
   Sweet & Sour Chicken
   Chow Mein or Fried Rice

Seafood
 Cashew                                                           6.95
 Prawn with lobster sauce                         6.95
 Prawn with black bean sauce                 6.95
 Sweet & Sour Prawn                                 6.95
 Curry Prawn (or calamari) *                   6.95
 Kung Pao Prawn (or calamari) *            6.95
 Szechwan Prawn *                                     6.95
 Vegetable with Prawn                               6.95

Vegetables
 Vegetable Deluxe                                       5.25
 Szechwan Bean Curd *                              5.25
 Braised Bean Curd                                      5.95

Fried Rice
 Vegetarian Fried Rice                                4.25
 Chicken Fried Rice                                     4.25
 B.B.Q. Pork Fried Rice                               4.25
 Beef Fried Rice                                             4.25
 Shrimp Fried Rice                                       5.25
 Combination Fried Rice                            5.25

Chow Mein
 Vegetarian Chow Mein                             4.25
 Chicken Chow Mein                                  4.25
 B.B.Q. Pork Chow Mein                            4.25
 Beef Chow Mein                                          4.25
 Shrimp Chow Mein                                    5.25
 Combination Chow Mein                        5.25

 * Hot & Spicy

Remember to work with your visual research; don’t pull design decisions 
from a hat. Note here the gold color is from a research image (page 4).
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Prices are subject to change
The beauty of this simple menu is that the background—which bleeds—can 
be commercially printed in large quantities, then A Taste of the Orient can update 
items as needed and print fresh copies on a desktop printer.

Pork
 Sweet & Sour Pork                                     5.95
 Garlic Pork (with vegetables)                 5.95
 Sa-tay Pork                                                   5.95
 Teriyaki Pork                                               5.95
 B.B.Q. Pork Bean Curd                               5.95

Poultry
 Broccoli Chicken                                         5.25
 Almond Chicken                                         5.25
 Cashew Chicken                                          5.25
 Szechwan Chicken *                                  5.25
 Kung Pao Chicken *                                   5.25
 Hunan Chicken *                                        5.95
 Curry Chicken *                                          5.95
 Sweet & Sour Chicken                              5.95
 Sa-tay Chicken                                             5.95
 Lemon Chicken                                           5.95
 Sesame Chicken                                           5.95
 Teriyaki Chicken                                        5.95
 Garlic Chicken                                             5.95

Beef
 Broccoli Beef                                                 5.95
 Mongolian Beef *                                        5.95
 Szechwan Beef *                                          5.95
 Kung Pao Beef *                                           5.95
 Hunan Beef *                                                6.95
 Beef with Oyster Sauce                             5.95
 Ginger Beef                                                   5.95
 Pepper Beef (with black bean)               5.95

Appetizers
 Fried Won Ton 

2.95 Egg Rolls (4) 
4.25 Paper-wrapped Chicken (8) 4.25 Fried Chicken Wings (10) 4.25 Pot Stickers (8) 
4.95 Fried Prawns (8) 
4.95 Fried Calamari 
5.95 Chinese Chicken Salad 4.25Soup

 Soup of the Day 
1.50 Egg Flower Soup 
4.25 Chicken Noodle Soup 
4.25 Beef Noodle Soup 
4.25 Won Ton Noodle Soup 4.25 Won Ton Soup 
4.25 Combination Won Ton 5.25 Hot & Sour Soup * 
5.25Combination Plates Combination Plate #1 5.25   Soup of the Day

   Paper-wrapped Chicken   Broccoli Beef
   Chow Mein or Fried Rice
 Combination Plate #2 6.25   Soup of the Day
   Fried Prawns
   Sweet & Sour Chicken   Chow Mein or Fried Rice

Seafood
 Cashew                                  

                         6.95

 Prawn with lobster sauce                         6.95

 Prawn with black bean sauce                 6.95

 Sweet & Sour Prawn                                 
6.95

 Curry Prawn (or calamari) *                   6.95

 Kung Pao Prawn (or calamari) *            6.95

 Szechwan Prawn *                                 
    6.95

 Vegetable with Prawn                               6.95

Vegetables
 Vegetable Deluxe                                 

      5.25

 Szechwan Bean Curd *                              5.25

 Braised Bean Curd                                  
    5.95

Fried Rice
 Vegetarian Fried Rice                                4.25

 Chicken Fried Rice                                 
    4.25

 B.B.Q. Pork Fried Rice                               4.25

 Beef Fried Rice                                  
           4.25

 Shrimp Fried Rice                                  
     5.25

 Combination Fried Rice                            5.25

Chow Mein
 Vegetarian Chow Mein                             4.25

 Chicken Chow Mein                                 
 4.25

 B.B.Q. Pork Chow Mein                            4.25

 Beef Chow Mein                                  
        4.25

 Shrimp Chow Mein                                  
  5.25

 Combination Chow Mein                        5.25

 * Hot & Spicy

The Orient

  

 3315 Northgate Blvd. #8, Sacramento

 Corner of Northgate & San Juan

 Open M–Sat. from 11–9, closed Sunday

 Dine-In • Take-Out • Catering

  916.922.1818

A taste of

Pre-printed shells . . . . . . items updated, printed . . . . . . and folded for presentation.
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By the way . . .
As an option, a heavy frame around each panel looks a lot  like a folding screen.

With the addition of the black frame, each panel becomes its own separate zone, a result similar to the original menu 
in which each category was boxed in. But unlike the unattractive original, several elements tie the zones together: 
1) The black silhouette spans two panels
2) The bamboo shadow spans all three panels
3) The red color repeats throughout.
An accordion fold like the screen would have been artistically truer, but the content of the menu wouldn’t permit it.

Pork
 Sweet & Sour Pork                                     5.95
 Garlic Pork (with vegetables)                 5.95
 Sa-tay Pork                                                   5.95
 Teriyaki Pork                                               5.95
 B.B.Q. Pork Bean Curd                               5.95

Poultry
 Broccoli Chicken                                         5.25
 Almond Chicken                                         5.25
 Cashew Chicken                                          5.25
 Szechwan Chicken *                                  5.25
 Kung Pao Chicken *                                   5.25
 Hunan Chicken *                                        5.95
 Curry Chicken *                                          5.95
 Sweet & Sour Chicken                              5.95
 Sa-tay Chicken                                             5.95
 Lemon Chicken                                           5.95
 Sesame Chicken                                           5.95
 Teriyaki Chicken                                        5.95
 Garlic Chicken                                             5.95

Beef
 Broccoli Beef                                                 5.95
 Mongolian Beef *                                        5.95
 Szechwan Beef *                                          5.95
 Kung Pao Beef *                                           5.95
 Hunan Beef *                                                6.95
 Beef with Oyster Sauce                             5.95
 Ginger Beef                                                   5.95
 Pepper Beef (with black bean)               5.95

Appetizers
 Fried Won Ton 

2.95 Egg Rolls (4) 
4.25 Paper-wrapped Chicken (8) 4.25 Fried Chicken Wings (10) 4.25 Pot Stickers (8) 
4.95 Fried Prawns (8) 
4.95 Fried Calamari 
5.95 Chinese Chicken Salad 4.25Soup

 Soup of the Day 
1.50 Egg Flower Soup 
4.25 Chicken Noodle Soup 
4.25 Beef Noodle Soup 
4.25 Won Ton Noodle Soup 4.25 Won Ton Soup 
4.25 Combination Won Ton 5.25 Hot & Sour Soup * 
5.25Combination Plates Combination Plate #1 5.25   Soup of the Day

   Paper-wrapped Chicken   Broccoli Beef
   Chow Mein or Fried Rice
 Combination Plate #2 6.25   Soup of the Day
   Fried Prawns
   Sweet & Sour Chicken   Chow Mein or Fried Rice

Seafood
 Cashew                                  

                         6.95

 Prawn with lobster sauce                         6.95

 Prawn with black bean sauce                 6.95

 Sweet & Sour Prawn                                 
6.95

 Curry Prawn (or calamari) *                   6.95

 Kung Pao Prawn (or calamari) *            6.95

 Szechwan Prawn *                                 
    6.95

 Vegetable with Prawn                               6.95

Vegetables
 Vegetable Deluxe                                 

      5.25

 Szechwan Bean Curd *                              5.25

 Braised Bean Curd                                  
    5.95

Fried Rice
 Vegetarian Fried Rice                                4.25

 Chicken Fried Rice                                 
    4.25

 B.B.Q. Pork Fried Rice                               4.25

 Beef Fried Rice                                  
           4.25

 Shrimp Fried Rice                                  
     5.25

 Combination Fried Rice                            5.25

Chow Mein
 Vegetarian Chow Mein                             4.25

 Chicken Chow Mein                                 
 4.25

 B.B.Q. Pork Chow Mein                            4.25

 Beef Chow Mein                                  
        4.25

 Shrimp Chow Mein                                  
  5.25

 Combination Chow Mein                        5.25

 * Hot & Spicy

Special Rice Plates
 (Entree without shrimp 4.25)
 1. Sa-tay Chicken or Pork
 2. Teriyaki Chicken or Pork
 3. Sweet & Sour Chicken or Pork
 4. Kung Pao Chicken
 5. Szechwan Beef *
 6. Mongolian Beef *
 7. Curry Chicken *
 8. Broccoli Beef
 9. Sesame Chicken
 10. Lemon Chicken
 11. Cashew Chicken
 12. Garlic Chicken
 13. Hunan Chicken
 14. Vegetable Deluxe *
 (Entree with shrimp 5.25)
 15. Cashew Shrimp
 16.  Kung Pao Shrimp
 17. Szechwan Shrimp *
 18. Curry Shrimp
 19. Shrimp with black bean sauce
 20. Shrimp with lobster sauce

Family Specials (2–3 people)
 Cantonese Family Special  14.95
   Soup of the Day
   Egg Rolls
   Broccoli Beef
   Teriyaki Chicken
   B.B.Q. Pork Fried Rice

 Mandarin Family Special  15.95
   Soup of the Day
   Fried Prawns
   Mongolian Beef
   Sa-tay Chicken
   B.B.Q. Pork Chow Mein

 House Family Special  16.95
   Soup of the Day
   Paper-wrapped Chicken
   Cashew Prawn
   Sesame Chicken
   Shrimp Chow Mein
 

The Orient

  

 3315 Northgate Blvd. #8, Sacramento

 Corner of Northgate & San Juan

 Open M–Sat. from 11–9, closed Sunday

 Dine-In • Take-Out • Catering

  916.922.1818
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Special Rice Plates
 (Entree without shrimp 4.25)
 1. Sa-tay Chicken or Pork
 2. Teriyaki Chicken or Pork
 3. Sweet & Sour Chicken or Pork
 4. Kung Pao Chicken
 5. Szechwan Beef *
 6. Mongolian Beef *
 7. Curry Chicken *
 8. Broccoli Beef
 9. Sesame Chicken
 10. Lemon Chicken
 11. Cashew Chicken
 12. Garlic Chicken
 13. Hunan Chicken
 14. Vegetable Deluxe *
 (Entree with shrimp 5.25)
 15. Cashew Shrimp
 16.  Kung Pao Shrimp
 17. Szechwan Shrimp *
 18. Curry Shrimp
 19. Shrimp with black bean sauce
 20. Shrimp with lobster sauce

Family Specials (2–3 people)
 Cantonese Family Special  14.95
   Soup of the Day
   Egg Rolls
   Broccoli Beef
   Teriyaki Chicken
   B.B.Q. Pork Fried Rice

 Mandarin Family Special  15.95
   Soup of the Day
   Fried Prawns
   Mongolian Beef
   Sa-tay Chicken
   B.B.Q. Pork Chow Mein

 House Family Special  16.95
   Soup of the Day
   Paper-wrapped Chicken
   Cashew Prawn
   Sesame Chicken
   Shrimp Chow Mein
 

The Orient

  

 3315 Northgate Blvd. #8, Sacramento

 Corner of Northgate & San Juan

 Open M–Sat. from 11–9, closed Sunday

 Dine-In • Take-Out • Catering

  916.922.1818
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Article resources  

Typefaces

1 (a–b) Ruach Plain | a) 43 pt, b) 16 pt

2 (a–d) Sanvito MM | a) 27 pt, b) 24 pt,
c) 13/13 pt, d) 13/15.6 pt 

Colors

C0 M90 Y80 K25

C0 M40 Y90 K15

C22 M26 Y34 K0

C2 M3 Y4 K0

3

4

5

6

1b

2d

3

4

5

2a

2b
2c

1a

Pork
 Sweet & Sour Pork                                     5.95
 Garlic Pork (with vegetables)                 5.95
 Sa-tay Pork                                                   5.95
 Teriyaki Pork                                               5.95
 B.B.Q. Pork Bean Curd                               5.95

Poultry
 Broccoli Chicken                                         5.25
 Almond Chicken                                         5.25
 Cashew Chicken                                          5.25
 Szechwan Chicken *                                  5.25
 Kung Pao Chicken *                                   5.25
 Hunan Chicken *                                        5.95
 Curry Chicken *                                          5.95
 Sweet & Sour Chicken                              5.95
 Sa-tay Chicken                                             5.95
 Lemon Chicken                                           5.95
 Sesame Chicken                                           5.95
 Teriyaki Chicken                                        5.95
 Garlic Chicken                                             5.95

Beef
 Broccoli Beef                                                 5.95
 Mongolian Beef *                                        5.95
 Szechwan Beef *                                          5.95
 Kung Pao Beef *                                           5.95
 Hunan Beef *                                                6.95
 Beef with Oyster Sauce                             5.95
 Ginger Beef                                                   5.95
 Pepper Beef (with black bean)               5.95

Appetizers
 Fried Won Ton 2.95
 Egg Rolls (4) 4.25
 Paper-wrapped Chicken (8) 4.25
 Fried Chicken Wings (10) 4.25
 Pot Stickers (8) 4.95
 Fried Prawns (8) 4.95
 Fried Calamari 5.95
 Chinese Chicken Salad 4.25

Soup
 Soup of the Day 1.50
 Egg Flower Soup 4.25
 Chicken Noodle Soup 4.25
 Beef Noodle Soup 4.25
 Won Ton Noodle Soup 4.25
 Won Ton Soup 4.25
 Combination Won Ton 5.25
 Hot & Sour Soup * 5.25

Combination Plates
 Combination Plate #1 5.25
   Soup of the Day
   Paper-wrapped Chicken
   Broccoli Beef
   Chow Mein or Fried Rice

 Combination Plate #2 6.25
   Soup of the Day
   Fried Prawns
   Sweet & Sour Chicken
   Chow Mein or Fried Rice

Seafood
 Cashew                                                           6.95
 Prawn with lobster sauce                         6.95
 Prawn with black bean sauce                 6.95
 Sweet & Sour Prawn                                 6.95
 Curry Prawn (or calamari) *                   6.95
 Kung Pao Prawn (or calamari) *            6.95
 Szechwan Prawn *                                     6.95
 Vegetable with Prawn                               6.95

Vegetables
 Vegetable Deluxe                                       5.25
 Szechwan Bean Curd *                              5.25
 Braised Bean Curd                                      5.95

Fried Rice
 Vegetarian Fried Rice                                4.25
 Chicken Fried Rice                                     4.25
 B.B.Q. Pork Fried Rice                               4.25
 Beef Fried Rice                                             4.25
 Shrimp Fried Rice                                       5.25
 Combination Fried Rice                            5.25

Chow Mein
 Vegetarian Chow Mein                             4.25
 Chicken Chow Mein                                  4.25
 B.B.Q. Pork Chow Mein                            4.25
 Beef Chow Mein                                          4.25
 Shrimp Chow Mein                                    5.25
 Combination Chow Mein                        5.25

 * Hot & Spicy

1b

2d

6
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Images

1 (a–d) Photos.com | a   b   c   d  

2 Photodisc/Veer.com
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Before & After magazine  
Before & After has been sharing its practical approach 
to graphic design since 1990. Because our modern world 
has made designers of us all (ready or not), Before & 
After is dedicated to making graphic design understand-
able, useful and even fun for everyone.  

John McWade Publisher and creative director
Gaye McWade Associate publisher
Vincent Pascual Staff designer
Dexter Mark Abellera Staff designer

Editorial board Gwen Amos, Carl Winther

Before & After magazine
323 Lincoln Street, Roseville, CA 95678 
Telephone 916-784-3880 
Fax 916-784-3995
E-mail mailbox@bamagazine.com  
www http://www.bamagazine.com

Copyright ©2005 Before & After magazine, ISSN 
1049-0035. All rights reserved 

You may pass this article around, but you may not alter 
it, and you may not charge for it. You may quote brief 
sections for review. If you do this, please credit Before 
& After magazine, and let us know. To feature free 
Before & After articles on your Web site, please contact 
us. For permission to include all or part of this article in 
another work, please contact us.

Subscribe to Before & After

Did you enjoy this article? Subscribe, and 

become a more capable, confident designer 

for pennies per article. To learn more, go to 

http://www.bamagazine.com/Subscribe

E-mail this article

To pass along a free copy of this article to 

others, click here.

Join our e-list

To be notified by e-mail of new articles as 

they become available, go to 

http://www.bamagazine.com/email
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Print: (Specify pages 22–31)

For presentation format  
Print: (Specify pages 1–20)

Before & After is made to fit your binder

Before & After articles are intended for permanent reference. All are titled and numbered. 

For the current table of contents, click here. To save time and paper, a paper-saver format of this article, 

suitable for one- or two-sided printing, is provided on the following pages.

Print 
Format: Landscape 

Page Size: Fit to Page
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s, n
o

n
e

 o
f it h

a
s 

b
e

e
n

 a
rtfu

lly p
re

se
n

te
d

.

In
sid

e
 sp

re
a

d
O

u
tsid

e
 sp

re
a

d

Lo
o

k
. R

e
ad

. Le
arn

.
B

egin
 th

e red
esign

 b
y research

in
g w

h
at C

h
in

ese lo
o

ks like. A
ctu

ally d
o

 th
e 

w
o

rk. D
o

n’t rely o
n

 yo
u

r m
em

o
ry, o

r yo
u

’ll en
d

 u
p

 u
sin

g clich
és like fo

rtu
n

e 
co

o
kies an

d
 ch

o
p

sticks.

Th
e

 w
o

rld
 o

f C
h

in
a

 
D

o
n

’t d
re

a
m

 u
p

 im
a

g
e

s
—

yo
u

’ll g
e

t b
e

tte
r re

su
lts (m

o
re

 
e

a
sily, to

o
) if yo

u
 lo

o
k

 th
e

m
 

u
p

! R
e

se
a

rch
 b

o
o

k
s, m

a
g

a
-

zin
e

s a
n

d
 o

n
lin

e
 p

h
o

to
 so

u
rc-

e
s. V

isit C
h

in
e

se
 re

sta
u

ra
n

ts. 
W

h
a

t to
 w

a
tch

 fo
r? P

a
y a

tte
n

-
tio

n
 to

 p
h

ysica
l a

ttrib
u

te
s 

lik
e

 sh
a

p
e

s, co
lo

rs, te
x

tu
re

s; 
se

n
su

a
l q

u
a

litie
s lik

e
 so

u
n

d
, 

sm
e

ll, to
u

ch
; a

n
d

 h
id

d
e

n
 

in
ta

n
g

ib
le

s, e
sp

e
cia

lly o
f h

is-
to

ry,  cu
ltu

re
 a

n
d

 tra
d

itio
n

.

F
o

rtu
n

e
 co

o
k

ie
 “M

oon 
cakes” predate M

ing D
ynasty; 

sw
eet, happy, circular, tan 

B
a

m
b

o
o

 
N

atural, elegant, 
cool, spare

S
cre

e
n

 Fine furniture, inlaid, 
historic, story-telling, seen in 
the restaurant

C
h

a
ra

cte
rs A

ncient, w
et 

brush, calligraphic,  fl uid, 
painstaking,  distinctively
O

riental 

C
o

lo
rs R

ed, gold leaf

M
a

sk
 A

ncient, heroic, religious, 
theatrical, colorful, m

ulti-textured

R
e

sta
u

ra
n

t N
eutral colors, spot 

lighting, intricate w
oodw

ork
W

o
k

 C
olorful, hot, fresh, 

round, arom
atic
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 a silh

o
u

e
tte

To
 create th

e illu
sio

n
 o

f a sh
ad

ow
 cast again

st th
e screen

—
o

r visib
le th

ro
u

gh
 

th
e screen

—
fi rst sep

arate th
e b

am
b

o
o

 fro
m

 its b
ackgro

u
n

d
.

W
hat w

e’re about to do is reduce the 
full-color photo to solid black &

 w
hite 

w
ith no grays. For an organic im

age 
like this one w

ith a distinct silhou-
ette and w

here precision is not vital, 
P

hoto shop’s Threshold slider is ideal.

In
ve

rt a
n

d
 cle

a
n

 u
p

 
Invert black and w

hite by selecting 
Im

age>
A

djustm
ents>

Invert. Erase any 
leftover spots and unw

anted parts. If 
necessary, use the B

rush tool to paint 
and redefi ne som

e parts. Save a copy 
(or a layer) of this im

age to use later.

O
p

e
n

 th
e

 im
a

g
e

 
C

hange its m
ode to G

rayscale 
(Im

age>
M

ode>
G

rayscale).

S
e

t th
e

 th
re

sh
o

ld
 

Select Im
age>

A
djustm

ents>
 

Threshold, check P
review

, and m
ove 

the Threshold slider. Everything 
above the threshold is w

hite, and 
everything below

 is black. A
djust for 

greatest clarity, then click O
K

. 

S
tart w

ith
 fo

rm
at an

d
 b

ack
g

ro
u

n
d

Tw
o

 im
ages can

 an
ch

o
r th

e d
esign

—
th

e fo
ld

in
g screen

 b
ecau

se it resem
b

les th
e 

fo
ld

ed
 sh

eet, an
d

 th
e b

am
b

o
o

 p
lan

t, w
h

ich
 w

ill m
ake a gracefu

l, p
lacid

 b
ackgro

u
n

d
.

C
ro

p
 th

e
 im

a
g

e
Like the story on a folding screen, crop the im

age 
to span the page and fi t its proportions. N

ote how
 it’s 

balanced—
about half im

age, half background.

Screens are usually decorated w
ith landscapes, plants 

and fi gures and typically have three or four  panels. C
on-

veniently enough, the tw
o-fold m

enu has three panels. 

W
ith the im

age in place, it’s tim
e to turn 

the background into a beautiful canvas 
on w

hich to paint our w
ords.



B
e

fo
re

&
A

fte
r | w

w
w

.bam
agazine.com

4 of 10

D
istin

ctive
ly O

rie
n

ta
l 0614

0614
 D

istin
ctive

ly O
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n
ta

l C
re

ate
 th

e
 illu

sio
n

 o
f n

atu
ral lig

h
tth

e
 w

all
Tu

rn
 th

e b
lack silh

o
u

ette in
to

 a so
ft sh

ad
ow

 b
y b

lu
rrin

g an
d

 ligh
ten

in
g. 

T
h

en
 p

ain
t d

ep
th

 an
d

 rad
ian

ce o
n

to
 th

e w
h

o
le p

age.

A
d

d
 d

e
p

th
 a

n
d

 ra
d

ia
n

ce
N

ext, m
im

ic the dark and light qualities of natu-
ral light. First, sam

ple a light and dark color from
 

the restaurant (1
). (This “color connection” is an 

artistic tie-in.) C
reate a new

 layer, and fi ll it w
ith 

the light color (2
). W

ith the darker color and a 
fairly large, soft brush, m

ake a sm
ooth, sw

eep-
ing stroke across the page (3

).

C
o

m
b

in
e

 
Set the new

 layer’s 
blending m

ode to 
M

ultiply, w
hich 

allow
s the bam

boo 
layer beneath to 
show

 through. The 
result is a convinc-
ing illusion of bam

-
boo seen through 
a paper screen.

B
lu

r a
n

d
 lig

h
te

n
 

R
eturn the im

age to C
M

Y
K

 M
ode 

(Im
age>

M
ode>

C
M

Y
K

). To soften, 
select Filter>

B
lur>

G
aussian B

lur, and 
enter a R

adius am
ount. W

hat you 
w

ant is a soft but still-distinct silhou-
ette, w

hich in this case w
as 10 pixels. 

Lighten the result by low
ering the 

opacity to about 10%
.

1

2

3

A
d

d
 b

am
b

o
o

 to
 th

e
 fo

re
g

ro
u

n
d

W
ith

 th
e sh

ad
ow

 an
d

 ligh
tin

g estab
lish

ed
, give th

e p
age m

o
re d

ep
th

 b
y ad

d
in

g 
b

lack b
am

b
o

o, w
h

ich
 yield

s a b
eau

tifu
l fo

regro
u

n
d

-b
ackgro

u
n

d
 effect.

C
o

n
n

e
ct 

G
et artistic! W

ith the B
rush tool, create your ow

n bam
-

boo plant by connecting the leaves (1
) and adding a 

stem
 (2

) that anchors plant to page. Then add another 
leaf (3

) to serve as a dow
nw

ard pointer to the list of 
m

enu item
s that w

ill eventually go beneath it.

S
e

p
a

ra
te

 
N

ote that as big as the shadow
 is, its light value and soft 

edges m
ake it recede. C

reate a forw
ard dim

ension by 
m

oving black leaves to the center of each panel. The con-
trasts of edge (hard and soft) and overlapping elem

ents 
(dark, m

edium
, light) results in real depth.

Iso
la

te
 

R
etrieve the saved black &

 
w

hite copy, m
ove its layer to 

the top, and set its blending 
m

ode to M
ultiply. W

ith the 
B

rush and Eraser tools, iso-
late a few

 bam
boo leaves.

1

2

3
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cal ico
n

T
h

e o
rigin

al b
ow

l is a go
o

d
, sim

p
le ico

n
 fo

r th
e restau

ran
t; it su

ggests eatin
g, 

ch
o

p
sticks say C

h
in

ese, an
d

 steam
 says h

o
t an

d
 fresh

. A
 stam

p
like effect m

akes 
it b

o
ld

er an
d

 even
 m

o
re C

h
in

ese.

3) S
h

a
rp

e
n

, th
e

n
 d

a
b

In Filter>
Sharpen>

U
nsharp 

M
ask, apply the follow

ing set-
tings: A

m
ount: 100; R

adius: 25; 
Threshold: 0. C

lick O
K

. N
ext, 

w
ith w

hite as the Foreground 
color, select the Spatter brush 
(here, num

ber 39). U
sing vari-

ous brush sizes and opacities, 
click-dab to soften and basi-
cally m

ess up the edges.

2) R
o

u
g

h
e

n
 th

e
 e

d
g

e
s

Set the Foreground and B
ack-

ground colors to red and 
w

hite, respectively. G
o to 

Filter>
Sketch>

Torn Edges, 
and for this size and resolu-
tion enter the follow

ing: Im
age 

 B
alance: 25; Sm

oothness: 1; 
C

ontrast: 15. C
lick O

K
.

In
 C

h
in

e
se

 b
ru

sh
 p

a
in

tin
g

s, a
 

sta
m

p
, w

h
ich

 is typ
ica

lly re
d

, 
is o

fte
n

 u
se

d
 a

s a
 sig

n
a

tu
re. Its

im
a

g
e

ry ca
n

 b
e

 e
vo

k
e

d
 b

y tu
rn

-
in

g
 th

e
 b

o
w

l in
to

 a
 sta

m
p

. 

A
 rubber stam

p begins as a fairly 
sharp im

age that degrades as it 
unevenly hits the paper and m

ore 
as the ink soaks in. Tim

e can further 
w

ear it dow
n. The result is a rich, 

interesting texture. H
ere’s how

 to 
m

im
ic that in P

hotoshop.

1) C
re

a
te

 th
e

 im
a

g
e

The original im
age can com

e 
from

 alm
ost any source (ours 

w
as a scan), so in som

e w
ay 

get it into a P
hotoshop fi le—

R
esolution 300 ppi, C

olor 
M

ode R
G

B
 C

olor, B
ackground 

C
ontents Transparent—

turn it 
into a selection, and knock it 
out of a shape you’ve draw

n. 
You w

ant the results to 
resem

ble the im
age above.

C
lick . . .

. . .dab . . .

r
C

h
o

c IC
G

 R
e

g
u

la
r

• N
o brush m

arks
• N

o bleeding
• C

lean edges and ends
• P

oster-like
Orient r

V
isig

o
th

 R
e

g
u

la
r

• Fat, slow
 strokes

• Fairly upright
• Soaked into the surface
• V

isible paper texture

O
rientr

R
u

a
ch

 P
la

in

• Fast, light strokes
• C

lean edges and rough ends
• C

losest to handw
ritten

• M
ost like the sam

ple
Orient

S
e

le
ct a d

isp
lay typ

e
N

o
th

in
g evo

kes C
h

in
a as read

ily as its u
n

iq
u

e, calligrap
h

ic ch
aracters, w

h
ich

 o
n

 th
e 

m
en

u
 m

u
st b

e co
n

veyed
 w

ith
 W

estern
-style typ

e. In
 gen

eral, yo
u

’ll see w
et b

ru
sh

, d
ry 

b
ru

sh
 an

d
 artifi cial styles. D

ry-b
ru

sh
 fo

n
t R

u
ach

 in
 th

is case is b
est.

W
e

t b
ru

sh

D
ry b

ru
sh

A
rtifi cia

l
R

e
fe

re
n

ce
 ch

a
ra

cte
r

O
nce you’ve found a style that 

you like, note how
 it’s draw

n. 
Pay attention to its edges, 

stroke ends, thick-to-thinness 
and general slant or direction, 

then look for sim
ilarities in 

W
estern typestyles.
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Tc

Appetizers
Fried W

on T
on

Egg R
olls (4)

Paper-w
rapped Chicken (8)

Fried Chicken W
ings (10)

Pot-Stickers (8)

Appetizers
Fried W

on Ton
Egg R

olls (4)
Paper-w

rapped C
hicken (8)

Fried C
hicken W

ings (10)
Pot-Stickers (8)

Appetizers
Fried W

on Ton
Egg R

olls (4)
Paper-w

rapped C
hicken (8)

Fried C
hicken W

ings (10)
Pot-Stickers (8)

C
a

llig
ra

p
h

ic  S
a

n
vito

Sim
ple lines, B

IG
 counters, B

IG
 aper-

tures and a sw
eeping stroke yield 

both clarity and calligraphic style 
w

ithout the brush details. Sanvito 
is a good com

plem
ent to R

uach.

S
a

n
s-se

rif  H
e

lve
tica

A
lthough popular, H

elvetica is not espe-
cially clear at sm

all sizes, because its 
sm

all apertures tend to close up. A
nd 

its straight lines are too rigid to com
ple-

m
ent free-fl ow

ing R
uach. 

R
o

m
a

n
 se

rif  Tim
e

s R
o

m
a

n

R
om

an serif faces are m
ore refi ned 

and generally easier to read, because 
serifs help m

ove the eye from
 letter to 

letter, but they’re full of tiny detail and 
stylistically very different from

 R
uach.

S
e

le
ct a co

m
p

le
m

e
n

tary te
x

t typ
e

face
Fo

r th
e sm

all typ
e u

sed
 fo

r listin
gs, lo

o
k fi rst fo

r clarity an
d

 th
en

 fo
r a co

m
p

lem
en

tary 
lin

e o
r sh

ap
e. C

larity u
su

ally req
u

ires “o
p

en” letterfo
rm

s an
d

 little d
etail.

Tc
Sm

all, but serifs 
help m

ove the eye
Too sm

all
Too straight

Tc
Sw

eeping 
and open

(Le
ft) A

n
a

lyze
 th

e
 b

a
m

b
o

o
 b

a
se

d
 o

n
 lin

e
 a

n
d

 d
ire

ctio
n

. N
o

te
 th

a
t its le

a
ve

s a
n

d
 

ste
m

s p
o

in
t in

 d
iffe

re
n

t d
ire

ctio
n

s—
h

o
rizo

n
ta

l, d
ia

g
o

n
a

l, ve
rtica

l—
w

h
ich

 cre
a

te
s 

a
 lo

t o
f m

o
ve

m
e

n
t a

n
d

 te
n

sio
n

. Th
is a

ctio
n

 ca
n

 b
e

 m
im

ick
e

d
 in

 th
e

 la
yo

u
t.

C
o

m
p

le
m

e
n

t im
ag

e
 an

d
 layo

u
t

W
ith

 th
e b

am
b

o
o

 alread
y o

n
 th

e p
age, create a relatio

n
sh

ip
 b

etw
een

 im
age, typ

e 
an

d
 layo

u
t b

y m
im

ickin
g its sp

iky visu
al q

u
alities.

P
la

ce
 th

e
 co

n
ta

ct 
in

fo
rm

a
tio

n
Since this is a take-
hom

e m
enu, the 

phone num
ber needs 

to be prom
inent; 

here, its size and 
right offset m

ake it 
stand out. R

em
aining 

inform
ation aligned 

w
ith the seal estab-

lishes continuity yet 
retains the staggered 
m

ovem
ent.

P
la

ce
 th

e
 

 b
u

sin
e

ss n
a

m
e

The bam
boo leaves 

have both size and 
directional differ-
ences. M

im
ic this 

w
ith tw

o type sizes 
and staggered place-
m

ent, w
hich m

oves 
the eye sim

ilarly and 
puts tension into 
the layout.

P
la

ce
 th

e
 se

a
l

W
hat size should 

the seal be? G
ener-

ally speaking, w
ork 

w
ith w

hat’s in front 
of you. H

ere, the 
bam

boo is govern-
ing the design, so 
give the seal sim

ilar 
m

ass, and place it 
directly beneath the 
dow

nw
ard-pointing 

“um
brella” about 

m
id-page. 

The Orient
A

 taste of

A
ligned w

ith seal for continuity

 
 

 
3315 N

orthgate Blvd. #8, Sacram
ento

 
Corner of N

orthgate &
 San Juan

 
O

pen M
–Sat. from

 11–9, closed Sunday

 
D

ine-In • Take-O
ut • Catering

 
 

916.922.1818

The Orient
A

 taste of
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p
e

at in
sid

e
W

h
at’s go

o
d

 fo
r th

e o
u

tsid
e is go

o
d

 fo
r th

e in
sid

e. C
reate co

n
tin

u
ity easily b

y 
rep

eatin
g th

e b
ackgro

u
n

d
, m

argin
s, co

lu
m

n
 gu

id
es an

d
 typ

e treatm
en

t in
sid

e.

R
e

p
e

a
t th

e
 b

a
ck

g
ro

u
n

d
 U

se the sam
e background im

age 
inside as outside, but to m

ake space for the m
enu item

s 
delete the foreground silhouettes. C

arry over m
argins, guides 

and type treatm
ent. N

ote that the bam
boo shadow

 is reversed 
to create the illusion of transparent rice paper.

P
ork

 
Sw

eet &
 Sour Pork

                                    5.95
 

G
arlic Pork (w

ith vegetables)                5.95
 

Sa-tay Pork                                                   5.95
 

T
eriyaki Pork

                                              5.95
 

B.B.Q
. Pork Bean Curd

                              5.95

P
oultry

 
Broccoli Chicken                                         5.25

 
A

lm
ond Chicken

                                        5.25
 

Cashew
 Chicken

                                         5.25
 

Szechw
an Chicken *                                  5.25

 
K

ung Pao Chicken *                                   5.25
 

H
unan Chicken *                                        5.95

 
Curry Chicken *                                          5.95

 
Sw

eet &
 Sour Chicken                              5.95

 
Sa-tay Chicken

                                            5.95
 

Lem
on Chicken                                           5.95

 
Sesam

e Chicken
                                          5.95

 
T

eriyaki Chicken
                                        5.95

 
G

arlic Chicken
                                            5.95

B
eef

 
Broccoli Beef                                                5.95

 
M

ongolian Beef *                                        5.95
 

Szechw
an Beef *                                         5.95

 
K

ung Pao Beef *                                          5.95
 

H
unan Beef *                                               6.95

 
Beef w

ith O
yster Sauce                             5.95

 
G

inger Beef                                                  5.95
 

Pepper Beef (w
ith black bean)               5.95

Appetizers
 

Fried W
on T

on 
2.95

 
Egg R

olls (4) 
4.25

 
Paper-w

rapped Chicken (8) 
4.25

 
Fried Chicken W

ings (10) 
4.25

 
Pot Stickers (8) 

4.95
 

Fried Praw
ns (8) 

4.95
 

Fried Calam
ari 

5.95
 

Chinese Chicken Salad 
4.25

Soup
 

Soup of the D
ay 

1.50
 

Egg Flow
er Soup 

4.25
 

Chicken N
oodle Soup 

4.25
 

Beef N
oodle Soup 

4.25
 

W
on T

on N
oodle Soup 

4.25
 

W
on T

on Soup 
4.25

 
Com

bination W
on T

on 
5.25

 
H

ot &
 Sour Soup * 

5.25

Combination P
lates

 
Com

bination Plate #1 
5.25

 
  

Soup of the D
ay

 
  

Paper-w
rapped Chicken

 
  

Broccoli Beef
 

  
Chow

 M
ein or Fried R

ice

 
Com

bination Plate #2 
6.25

 
  

Soup of the D
ay

 
  

Fried Praw
ns

 
  

Sw
eet &

 Sour Chicken
 

  
Chow

 M
ein or Fried R

ice

Seafood
 

Cashew
                                                          6.95

 
Praw

n w
ith lobster sauce                        6.95

 
Praw

n w
ith black bean sauce                 6.95

 
Sw

eet &
 Sour Praw

n                                 6.95
 

Curry Praw
n (or calam

ari) *                   6.95
 

K
ung Pao Praw

n (or calam
ari) *           6.95

 
Szechw

an Praw
n *                                     6.95

 
V

egetable w
ith Praw

n
                              6.95

Vegetables
 

V
egetable D

eluxe                                       5.25
 

Szechw
an Bean Curd *                             5.25

 
Braised Bean Curd

                                     5.95

Fried R
ice

 
V

egetarian Fried R
ice

                               4.25
 

Chicken Fried R
ice                                     4.25

 
B.B.Q

. Pork Fried R
ice                               4.25

 
Beef Fried R

ice                                            4.25
 

Shrim
p Fried R

ice                                      5.25
 

Com
bination Fried R

ice                           5.25

Chow M
ein

 
V

egetarian Chow
 M

ein
                            4.25

 
Chicken Chow

 M
ein                                  4.25

 
B.B.Q

. Pork Chow
 M

ein
                            4.25

 
Beef Chow

 M
ein

                                         4.25
 

Shrim
p Chow

 M
ein

                                   5.25
 

Com
bination Chow

 M
ein

                        5.25
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Special R
ice P

lates
 (Entree w

ithout shrim
p 4.25)

 
1. 

Sa-tay Chicken or Pork
 

2. 
T

eriyaki Chicken or Pork
 

3. 
Sw

eet &
 Sour Chicken or Pork

 
4. 

K
ung Pao Chicken

 
5. 

Szechw
an Beef *

 
6. 

M
ongolian Beef *

 
7. 

Curry Chicken *
 

8. 
Broccoli Beef

 
9. 

Sesam
e Chicken

 10. 
Lem

on Chicken
 11. 

Cashew
 Chicken

 12. 
G

arlic Chicken
 13. 

H
unan Chicken

 14. 
V

egetable D
eluxe *

 (Entree w
ith shrim

p 5.25)
 15. 

Cashew
 Shrim

p
 16.  K

ung Pao Shrim
p

 17. 
Szechw

an Shrim
p *

 18. 
Curry Shrim

p
 19. 

Shrim
p w

ith black bean sauce
 20. 

Shrim
p w

ith lobster sauce

Family Specials (2–3 people)
 

Cantonese Fam
ily Special  

14.95
 

  
Soup of the D

ay
 

  
Egg R

olls
 

  
Broccoli Beef

 
  

T
eriyaki Chicken

 
  

B.B.Q
. Pork Fried R

ice

 
M

andarin Fam
ily Special  

15.95
 

  
Soup of the D

ay
 

  
Fried Praw

ns
 

  
M

ongolian Beef
 

  
Sa-tay Chicken

 
  

B.B.Q
. Pork Chow

 M
ein

 
H

ouse Fam
ily Special  

16.95
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Cashew

 Praw
n

 
  

Sesam
e Chicken

 
  

Shrim
p Chow

 M
ein
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o
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n
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rigin

al m
en

u
 are u

n
n

ecessary; th
e w

h
ite sp

ace alo
n

e is 
su

ffi cien
t to

 sep
arate th

e sectio
n

s b
eau

tifu
lly. Sim

p
le tab

 in
d

en
ts id

en
tify co

lu
m

n
ar 

elem
en

ts an
d

 m
im

ic th
e b

am
b

o
o, to

o. 

Special R
ice P

lates
 (Entree w

ithout shrim
p 4.25)

 
1. 

Sa-tay Chicken or Pork
 

2. 
T

eriyaki Chicken or Pork
 

3. 
Sw

eet &
 Sour Chicken or Pork

 
4. 

K
ung Pao Chicken

 
5. 

Szechw
an Beef *

 
6. 

M
ongolian Beef *

 
7. 

Curry Chicken *
 

8. 
Broccoli Beef

 
9. 

Sesam
e Chicken

 10. 
Lem

on Chicken
 11. 

Cashew
 Chicken

 12. 
G

arlic Chicken
 13. 

H
unan Chicken

 14. 
V

egetable D
eluxe *

 (Entree w
ith shrim

p 5.25)
 15. 

Cashew
 Shrim

p
 16.  K

ung Pao Shrim
p

 17. 
Szechw

an Shrim
p *

 18. 
Curry Shrim

p
 19. 

Shrim
p w

ith black bean sauce
 20. 

Shrim
p w

ith lobster sauce

Family Specials (2–3 people)
 

Cantonese Fam
ily Special  

14.95
 

  
Soup of the D

ay
 

  
Egg R

olls
 

  
Broccoli Beef

 
  

T
eriyaki Chicken

 
  

B.B.Q
. Pork Fried R

ice

 
M

andarin Fam
ily Special  

15.95
 

  
Soup of the D

ay
 

  
Fried Praw

ns
 

  
M

ongolian Beef
 

  
Sa-tay Chicken

 
  

B.B.Q
. Pork Chow

 M
ein

 
H

ouse Fam
ily Special  

16.95
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Cashew

 Praw
n

 
  

Sesam
e Chicken

 
  

Shrim
p Chow

 M
ein

 

The Orient
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orthgate Blvd. #8, Sacram
ento
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orthgate &
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O
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–Sat. from
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D
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A
 taste of

Ta
b

 in
d

e
n

ts rather than fl ush-left alignm
ent yield text 

blocks that have staggered edges sim
ilar to the bam

boo 
and cover layout.

V
isu

a
l re

la
tio

n
sh

ip
s 

A
bove, the headline x-height deter-

m
ines the text size. B

elow
, its overall 

height governs section spacing. Family Specials (2–3 people)
 

Cantonese Fam
ily Special  

  14.95
 

  
Soup of the D

ay
 

  
Egg R

olls
 

  
Broccoli Beef

 
  

T
eriyaki Chicken

 
  

B.B.Q
. Pork Fried R

ice

 
M

andarin Fam
ily Special  

             15.95
 

  
Soup of the D

ay
 

  
Fried Praw

ns
 

Fam
ily Specials

Family Specials
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The Orient

 
 

 
3315 N

orthgate Blvd. #8, Sacram
ento

 
Corner of N

orthgate &
 San Juan

 
O
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–Sat. from

 11–9, closed Sunday

 
D

ine-In • Take-O
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A
 taste of

Special R
ice P

lates
 (Entree w

ithout shrim
p 4.25)

 
1. 

Sa-tay Chicken or Pork
 

2. 
T

eriyaki Chicken or Pork
 

3. 
Sw

eet &
 Sour Chicken or Pork

 
4. 

K
ung Pao Chicken

 
5. 

Szechw
an Beef *

 
6. 

M
ongolian Beef *

 
7. 

Curry Chicken *
 

8. 
Broccoli Beef

 
9. 

Sesam
e Chicken

 10. 
Lem

on Chicken
 11. 

Cashew
 Chicken

 12. 
G

arlic Chicken
 13. 

H
unan Chicken

 14. 
V

egetable D
eluxe *

 (Entree w
ith shrim

p 5.25)
 15. 

Cashew
 Shrim

p
 16.  K

ung Pao Shrim
p

 17. 
Szechw

an Shrim
p *

 18. 
Curry Shrim

p
 19. 

Shrim
p w

ith black bean sauce
 20. 

Shrim
p w

ith lobster sauce

 
 

916.922.1818

Family Specials (2–3 people)
 

Cantonese Fam
ily Special  

14.95
 

  
Soup of the D

ay
 

  
Egg R

olls
 

  
Broccoli Beef

 
  

T
eriyaki Chicken

 
  

B.B.Q
. Pork Fried R

ice

 
M

andarin Fam
ily Special  

15.95
 

  
Soup of the D

ay
 

  
Fried Praw

ns
 

  
M

ongolian Beef
 

  
Sa-tay Chicken

 
  

B.B.Q
. Pork Chow

 M
ein

 
H

ouse Fam
ily Special  

16.95
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Cashew

 Praw
n

 
  

Sesam
e Chicken

 
  

Shrim
p Chow

 M
ein

 

P
h

o
n

e
 n

u
m

b
e

r in gold 
 distinguishes it from

 the food 
categories and adds another 
level of depth. 

C
o

lo
r u

n
ifi e

s th
e

 e
le

m
e

n
ts

It’s tim
e to

 ad
d

 co
lo

r. O
u

r eyes co
n

n
ect sim

ilarities—
th

is like th
at. C

o
lo

r th
e 

h
ead

lin
es to

 m
atch

 th
e seal alread

y o
n

 th
e cover. T

h
e co

n
trast o

f go
ld

 ad
d

s d
ep

th
 

an
d

 sp
ices u

p
 th

e h
o

t p
alette. 

P
ork

 
Sw

eet &
 Sour Pork

                                    5.95
 

G
arlic Pork (w

ith vegetables)                5.95
 

Sa-tay Pork                                                   5.95
 

T
eriyaki Pork

                                              5.95
 

B.B.Q
. Pork Bean Curd

                              5.95

P
oultry

 
Broccoli Chicken                                         5.25

 
A

lm
ond Chicken

                                        5.25
 

Cashew
 Chicken

                                         5.25
 

Szechw
an Chicken *                                  5.25

 
K

ung Pao Chicken *                                   5.25
 

H
unan Chicken *                                        5.95

 
Curry Chicken *                                          5.95

 
Sw

eet &
 Sour Chicken                              5.95

 
Sa-tay Chicken

                                            5.95
 

Lem
on Chicken                                           5.95

 
Sesam

e Chicken
                                          5.95

 
T

eriyaki Chicken
                                        5.95

 
G

arlic Chicken
                                            5.95

B
eef

 
Broccoli Beef                                                5.95

 
M

ongolian Beef *                                        5.95
 

Szechw
an Beef *                                         5.95

 
K

ung Pao Beef *                                          5.95
 

H
unan Beef *                                               6.95

 
Beef w

ith O
yster Sauce                             5.95

 
G

inger Beef                                                  5.95
 

Pepper Beef (w
ith black bean)               5.95

Appetizers
 

Fried W
on T

on 
2.95

 
Egg R

olls (4) 
4.25

 
Paper-w

rapped Chicken (8) 
4.25

 
Fried Chicken W

ings (10) 
4.25

 
Pot Stickers (8) 

4.95
 

Fried Praw
ns (8) 

4.95
 

Fried Calam
ari 

5.95
 

Chinese Chicken Salad 
4.25

Soup
 

Soup of the D
ay 

1.50
 

Egg Flow
er Soup 

4.25
 

Chicken N
oodle Soup 

4.25
 

Beef N
oodle Soup 

4.25
 

W
on T

on N
oodle Soup 

4.25
 

W
on T

on Soup 
4.25

 
Com

bination W
on T

on 
5.25

 
H

ot &
 Sour Soup * 

5.25

Combination P
lates

 
Com

bination Plate #1 
5.25

 
  

Soup of the D
ay

 
  

Paper-w
rapped Chicken

 
  

Broccoli Beef
 

  
Chow

 M
ein or Fried R

ice

 
Com

bination Plate #2 
6.25

 
  

Soup of the D
ay

 
  

Fried Praw
ns

 
  

Sw
eet &

 Sour Chicken
 

  
Chow

 M
ein or Fried R

ice

Seafood
 

Cashew
                                                          6.95

 
Praw

n w
ith lobster sauce                        6.95

 
Praw

n w
ith black bean sauce                 6.95

 
Sw

eet &
 Sour Praw

n                                 6.95
 

Curry Praw
n (or calam

ari) *                   6.95
 

K
ung Pao Praw

n (or calam
ari) *           6.95

 
Szechw

an Praw
n *                                     6.95

 
V

egetable w
ith Praw

n
                              6.95

Vegetables
 

V
egetable D

eluxe                                       5.25
 

Szechw
an Bean Curd *                             5.25

 
Braised Bean Curd

                                     5.95

Fried R
ice

 
V

egetarian Fried R
ice

                               4.25
 

Chicken Fried R
ice                                     4.25

 
B.B.Q

. Pork Fried R
ice                               4.25

 
Beef Fried R

ice                                            4.25
 

Shrim
p Fried R

ice                                      5.25
 

Com
bination Fried R

ice                           5.25

Chow M
ein

 
V

egetarian Chow
 M

ein
                            4.25

 
Chicken Chow

 M
ein                                  4.25

 
B.B.Q

. Pork Chow
 M

ein
                            4.25

 
Beef Chow

 M
ein

                                         4.25
 

Shrim
p Chow

 M
ein

                                   5.25
 

Com
bination Chow

 M
ein

                        5.25

 
* H

ot &
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R
em

em
ber to w

ork w
ith your visual research; don’t pull design decisions 

from
 a hat. N

ote here the gold color is from
 a research im

age  (page 4
).

P
rice

s are
 su

b
je

ct to
 ch

an
g

e
T

h
e b

eau
ty o

f th
is sim

p
le m

en
u

 is th
at th

e b
ackgro

u
n

d
—

w
h

ich
 b

leed
s—

can
 

b
e co

m
m

ercially p
rin

ted
 in

 large q
u

an
tities, th

en
 A

 Taste of th
e O

rien
t can

 u
p

d
ate 

item
s as n

eed
ed

 an
d

 p
rin

t fresh
 co

p
ies o

n
 a d

eskto
p

 p
rin

ter.

P
ork

 
Sw

eet &
 Sour Pork

                                    5.95
 

G
arlic Pork (w

ith vegetables)                5.95
 

Sa-tay Pork                                                   5.95
 

T
eriyaki Pork

                                              5.95
 

B.B.Q
. Pork Bean Curd

                              5.95

P
oultry

 
Broccoli Chicken                                         5.25

 
A

lm
ond Chicken

                                        5.25
 

Cashew
 Chicken

                                         5.25
 

Szechw
an Chicken *                                  5.25

 
K

ung Pao Chicken *                                   5.25
 

H
unan Chicken *                                        5.95

 
Curry Chicken *                                          5.95

 
Sw

eet &
 Sour Chicken                              5.95

 
Sa-tay Chicken

                                            5.95
 

Lem
on Chicken                                           5.95

 
Sesam

e Chicken
                                          5.95

 
T

eriyaki Chicken
                                        5.95

 
G

arlic Chicken
                                            5.95

B
eef

 
Broccoli Beef                                                5.95

 
M

ongolian Beef *                                        5.95
 

Szechw
an Beef *                                         5.95

 
K

ung Pao Beef *                                          5.95
 

H
unan Beef *                                               6.95

 
Beef w

ith O
yster Sauce                             5.95

 
G

inger Beef                                                  5.95
 

Pepper Beef (w
ith black bean)               5.95

Appetizers
 

Fried W
on T

on 
2.95

 
Egg R

olls (4) 
4.25

 
Paper-w

rapped Chicken (8) 
4.25

 
Fried Chicken W

ings (10) 
4.25

 
Pot Stickers (8) 

4.95
 

Fried Praw
ns (8) 

4.95
 

Fried Calam
ari 

5.95
 

Chinese Chicken Salad 
4.25

Soup
 

Soup of the D
ay 

1.50
 

Egg Flow
er Soup 

4.25
 

Chicken N
oodle Soup 

4.25
 

Beef N
oodle Soup 

4.25
 

W
on T

on N
oodle Soup 

4.25
 

W
on T

on Soup 
4.25

 
Com

bination W
on T

on 
5.25

 
H

ot &
 Sour Soup * 

5.25
Combination P

lates
 

Com
bination Plate #1 

5.25
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Broccoli Beef

 
  

Chow
 M

ein or Fried R
ice

 
Com

bination Plate #2 
6.25

 
  

Soup of the D
ay

 
  

Fried Praw
ns

 
  

Sw
eet &

 Sour Chicken
 

  
Chow

 M
ein or Fried R

ice

Seafood
 

Cashew
                                                          6.95

 
Praw

n w
ith lobster sauce                         6.95

 
Praw

n w
ith black bean sauce                 6.95

 
Sw

eet &
 Sour Praw

n                                 6.95

 
Curry Praw

n (or calam
ari) *                   6.95

 
K

ung Pao Praw
n (or calam

ari) *            6.95

 
Szechw

an Praw
n *                                     6.95

 
V

egetable w
ith Praw

n
                              6.95

Vegetables
 

V
egetable D

eluxe                                       5.25

 
Szechw

an Bean Curd *                              5.25

 
Braised Bean Curd

                                     5.95

Fried R
ice

 
V

egetarian Fried R
ice

                               4.25

 
Chicken Fried R

ice                                     4.25

 
B.B.Q

. Pork Fried R
ice                               4.25

 
Beef Fried R

ice                                             4.25

 
Shrim

p Fried R
ice                                       5.25

 
Com

bination Fried R
ice                            5.25

Chow M
ein

 
V

egetarian Chow
 M

ein
                            4.25

 
Chicken Chow

 M
ein                                  4.25

 
B.B.Q

. Pork Chow
 M

ein
                            4.25

 
Beef Chow

 M
ein

                                         4.25

 
Shrim

p Chow
 M

ein
                                   5.25

 
Com

bination Chow
 M

ein
                        5.25
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A

s an
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p
tio

n
, a h

eavy fram
e aro

u
n

d
 each

 p
an

el lo
o

ks a lot like a fo
ld

in
g screen

.

W
ith the addition of the black fram

e, each panel becom
es its ow

n separate zone, a result sim
ilar to the original m

enu 
in w

hich each category w
as boxed in. B

ut unlike the unattractive original, several elem
ents tie the zones together: 

1) The black silhouette spans tw
o panels

2) The bam
boo shadow

 spans all three panels
3) The red color repeats throughout.
A

n accordion fold like the screen w
ould have been artistically truer, but the content of the m

enu w
ouldn’t perm

it it.

P
ork

 
Sw

eet &
 Sour Pork

                                    5.95
 

G
arlic Pork (w

ith vegetables)                5.95
 

Sa-tay Pork                                                   5.95
 

T
eriyaki Pork

                                              5.95
 

B.B.Q
. Pork Bean Curd

                              5.95

P
oultry

 
Broccoli Chicken                                         5.25

 
A

lm
ond Chicken

                                        5.25
 

Cashew
 Chicken

                                         5.25
 

Szechw
an Chicken *                                  5.25

 
K

ung Pao Chicken *                                   5.25
 

H
unan Chicken *                                        5.95

 
Curry Chicken *                                          5.95

 
Sw

eet &
 Sour Chicken                              5.95

 
Sa-tay Chicken

                                            5.95
 

Lem
on Chicken                                           5.95

 
Sesam

e Chicken
                                          5.95

 
T

eriyaki Chicken
                                        5.95

 
G

arlic Chicken
                                            5.95

B
eef

 
Broccoli Beef                                                5.95

 
M

ongolian Beef *                                        5.95
 

Szechw
an Beef *                                         5.95

 
K

ung Pao Beef *                                          5.95
 

H
unan Beef *                                               6.95

 
Beef w

ith O
yster Sauce                             5.95

 
G

inger Beef                                                  5.95
 

Pepper Beef (w
ith black bean)               5.95

Appetizers
 

Fried W
on T

on 
2.95

 
Egg R

olls (4) 
4.25

 
Paper-w

rapped Chicken (8) 
4.25

 
Fried Chicken W

ings (10) 
4.25

 
Pot Stickers (8) 

4.95
 

Fried Praw
ns (8) 

4.95
 

Fried Calam
ari 

5.95
 

Chinese Chicken Salad 
4.25

Soup
 

Soup of the D
ay 

1.50
 

Egg Flow
er Soup 

4.25
 

Chicken N
oodle Soup 

4.25
 

Beef N
oodle Soup 

4.25
 

W
on T

on N
oodle Soup 

4.25
 

W
on T

on Soup 
4.25

 
Com

bination W
on T

on 
5.25

 
H

ot &
 Sour Soup * 

5.25
Combination P

lates
 

Com
bination Plate #1 

5.25
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Broccoli Beef

 
  

Chow
 M

ein or Fried R
ice

 
Com

bination Plate #2 
6.25

 
  

Soup of the D
ay

 
  

Fried Praw
ns

 
  

Sw
eet &

 Sour Chicken
 

  
Chow

 M
ein or Fried R

ice

Seafood
 

Cashew
                                                          6.95

 
Praw

n w
ith lobster sauce                         6.95

 
Praw

n w
ith black bean sauce                 6.95

 
Sw

eet &
 Sour Praw

n                                 6.95

 
Curry Praw

n (or calam
ari) *                   6.95

 
K

ung Pao Praw
n (or calam

ari) *            6.95

 
Szechw

an Praw
n *                                     6.95

 
V

egetable w
ith Praw

n
                              6.95

Vegetables
 

V
egetable D

eluxe                                       5.25

 
Szechw

an Bean Curd *                              5.25

 
Braised Bean Curd

                                     5.95

Fried R
ice

 
V

egetarian Fried R
ice

                               4.25

 
Chicken Fried R

ice                                     4.25

 
B.B.Q

. Pork Fried R
ice                               4.25

 
Beef Fried R

ice                                             4.25

 
Shrim

p Fried R
ice                                       5.25

 
Com

bination Fried R
ice                            5.25

Chow M
ein

 
V

egetarian Chow
 M

ein
                            4.25

 
Chicken Chow

 M
ein                                  4.25

 
B.B.Q

. Pork Chow
 M

ein
                            4.25

 
Beef Chow

 M
ein

                                         4.25

 
Shrim

p Chow
 M

ein
                                   5.25

 
Com

bination Chow
 M

ein
                        5.25
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Special R
ice P

lates
 (Entree w

ithout shrim
p 4.25)

 
1. 

Sa-tay Chicken or Pork
 

2. 
T

eriyaki Chicken or Pork
 

3. 
Sw

eet &
 Sour Chicken or Pork

 
4. 

K
ung Pao Chicken

 
5. 

Szechw
an Beef *

 
6. 

M
ongolian Beef *

 
7. 

Curry Chicken *
 

8. 
Broccoli Beef

 
9. 

Sesam
e Chicken

 10. 
Lem

on Chicken
 11. 

Cashew
 Chicken

 12. 
G

arlic Chicken
 13. 

H
unan Chicken

 14. 
V

egetable D
eluxe *

 (Entree w
ith shrim

p 5.25)
 15. 

Cashew
 Shrim

p
 16.  K

ung Pao Shrim
p

 17. 
Szechw

an Shrim
p *

 18. 
Curry Shrim

p
 19. 

Shrim
p w

ith black bean sauce
 20. 

Shrim
p w

ith lobster sauce

Family Specials (2–3 people)
 

Cantonese Fam
ily Special  

14.95
 

  
Soup of the D

ay
 

  
Egg R

olls
 

  
Broccoli Beef

 
  

T
eriyaki Chicken

 
  

B.B.Q
. Pork Fried R

ice

 
M

andarin Fam
ily Special  

15.95
 

  
Soup of the D

ay
 

  
Fried Praw

ns
 

  
M

ongolian Beef
 

  
Sa-tay Chicken

 
  

B.B.Q
. Pork Chow

 M
ein

 
H

ouse Fam
ily Special  

16.95
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Cashew

 Praw
n

 
  

Sesam
e Chicken

 
  

Shrim
p Chow

 M
ein

 

The Orient
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orthgate &
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O

pen M
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D
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ut • Catering

 
 

916.922.1818

A
 taste of

Special R
ice P

lates
 (Entree w

ithout shrim
p 4.25)

 
1. 

Sa-tay Chicken or Pork
 

2. 
T

eriyaki Chicken or Pork
 

3. 
Sw

eet &
 Sour Chicken or Pork

 
4. 

K
ung Pao Chicken

 
5. 

Szechw
an Beef *

 
6. 

M
ongolian Beef *

 
7. 

Curry Chicken *
 

8. 
Broccoli Beef

 
9. 

Sesam
e Chicken

 10. 
Lem

on Chicken
 11. 

Cashew
 Chicken

 12. 
G

arlic Chicken
 13. 

H
unan Chicken

 14. 
V

egetable D
eluxe *

 (Entree w
ith shrim

p 5.25)
 15. 

Cashew
 Shrim

p
 16.  K

ung Pao Shrim
p

 17. 
Szechw

an Shrim
p *

 18. 
Curry Shrim

p
 19. 

Shrim
p w

ith black bean sauce
 20. 

Shrim
p w

ith lobster sauce

Fam
ily Specials (2–3 people)

 
Cantonese Fam

ily Special  
14.95

 
  

Soup of the D
ay

 
  

Egg R
olls

 
  

Broccoli Beef
 

  
T

eriyaki Chicken
 

  
B.B.Q

. Pork Fried R
ice

 
M

andarin Fam
ily Special  

15.95
 

  
Soup of the D

ay
 

  
Fried Praw

ns
 

  
M

ongolian Beef
 

  
Sa-tay Chicken

 
  

B.B.Q
. Pork Chow

 M
ein

 
H

ouse Fam
ily Special  

16.95
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Cashew

 Praw
n

 
  

Sesam
e Chicken

 
  

Shrim
p Chow

 M
ein

 

The Orient

 
 

 
3315 N

orthgate Blvd. #8, Sacram
ento

 
Corner of N

orthgate &
 San Juan

 
O

pen M
–Sat. from

 11–9, closed Sunday

 
D

ine-In • Take-O
ut • Catering

 
 

916.922.1818
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P
ork

 
Sw

eet &
 Sour Pork

                                    5.95
 

G
arlic Pork (w

ith vegetables)                5.95
 

Sa-tay Pork                                                   5.95
 

T
eriyaki Pork

                                              5.95
 

B.B.Q
. Pork Bean Curd

                              5.95

P
oultry

 
Broccoli Chicken                                         5.25

 
A

lm
ond Chicken

                                        5.25
 

Cashew
 Chicken

                                         5.25
 

Szechw
an Chicken *                                  5.25

 
K

ung Pao Chicken *                                   5.25
 

H
unan Chicken *                                        5.95

 
Curry Chicken *                                          5.95

 
Sw

eet &
 Sour Chicken                              5.95

 
Sa-tay Chicken

                                            5.95
 

Lem
on Chicken

                                           5.95
 

Sesam
e Chicken

                                          5.95
 

T
eriyaki Chicken

                                        5.95
 

G
arlic Chicken

                                            5.95

B
eef

 
Broccoli Beef                                                5.95

 
M

ongolian Beef *                                        5.95
 

Szechw
an Beef *                                         5.95

 
K

ung Pao Beef *                                          5.95
 

H
unan Beef *                                               6.95

 
Beef w

ith O
yster Sauce                             5.95

 
G

inger Beef                                                  5.95
 

Pepper Beef (w
ith black bean)               5.95

Appetizers
 

Fried W
on T

on 
2.95

 
Egg R

olls (4) 
4.25

 
Paper-w

rapped Chicken (8) 
4.25

 
Fried Chicken W

ings (10) 
4.25

 
Pot Stickers (8) 

4.95
 

Fried Praw
ns (8) 

4.95
 

Fried Calam
ari 

5.95
 

Chinese Chicken Salad 
4.25

Soup
 

Soup of the D
ay 

1.50
 

Egg Flow
er Soup 

4.25
 

Chicken N
oodle Soup 

4.25
 

Beef N
oodle Soup 

4.25
 

W
on T

on N
oodle Soup 

4.25
 

W
on T

on Soup 
4.25

 
Com

bination W
on T

on 
5.25

 
H

ot &
 Sour Soup * 

5.25

Com
bination P

lates
 

Com
bination Plate #1 

5.25
 

  
Soup of the D

ay
 

  
Paper-w

rapped Chicken
 

  
Broccoli Beef

 
  

Chow
 M

ein or Fried R
ice

 
Com

bination Plate #2 
6.25

 
  

Soup of the D
ay

 
  

Fried Praw
ns

 
  

Sw
eet &

 Sour Chicken
 

  
Chow

 M
ein or Fried R

ice

Seafood
 

Cashew
                                                          6.95

 
Praw

n w
ith lobster sauce                        6.95

 
Praw

n w
ith black bean sauce                 6.95

 
Sw

eet &
 Sour Praw

n                                 6.95
 

Curry Praw
n (or calam

ari) *                   6.95
 

K
ung Pao Praw

n (or calam
ari) *           6.95

 
Szechw

an Praw
n *                                     6.95

 
V

egetable w
ith Praw

n
                              6.95

Vegetables
 

V
egetable D

eluxe                                       5.25
 

Szechw
an Bean Curd *                             5.25

 
Braised Bean Curd

                                     5.95

Fried R
ice

 
V

egetarian Fried R
ice

                               4.25
 

Chicken Fried R
ice                                     4.25

 
B.B.Q

. Pork Fried R
ice                               4.25

 
Beef Fried R

ice                                            4.25
 

Shrim
p Fried R

ice                                      5.25
 

Com
bination Fried R

ice                           5.25

Chow M
ein

 
V

egetarian Chow
 M

ein
                            4.25

 
Chicken Chow

 M
ein                                  4.25

 
B.B.Q

. Pork Chow
 M

ein
                            4.25

 
Beef Chow

 M
ein

                                         4.25
 

Shrim
p Chow

 M
ein

                                   5.25
 

Com
bination Chow

 M
ein

                        5.25

 
* H

ot &
 Spicy

1b2d
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